Kurzweil 1000
Version 14
Installation and New Features Guide
1 Installation and Registration

This section covers the product package, the software and hardware requirements, and installation for Kurzweil 1000™.

What's in the Product Package?

The following is a general list of contents. The items you receive may be a subset of this list, and may depend on whether you are a new customer or an upgrade customer, and may depend on which version you are upgrading from.

- The Kurzweil 1000 software DVD, which includes the American Heritage Dictionary Pronunciation WAV Files, NeoSpeech VoiceText voices, Microsoft Speech Platform Runtime 11 Installer, Classic Literature files, and a set of documentation in multiple file formats.

- The Kurzweil 1000 Quick Reference Guide.

- The Kurzweil 1000 Installation and New Features Guide.

Possibly a Certificate of Ownership bearing the serial number for the product.

You can call Kurzweil Educational Systems Customer Service to request any of the guides if they are not included in your package. In the U.S. and Canada use 800-894-5374. For international calls use 781-276-0600.

Some of the print material is available in other file formats such as MP3 from www.kurzweiledu.com.

Minimum Software and Hardware Requirements

Processor: 1 GHz or faster.

Memory: Minimum 2 GB RAM.

Hard Disk Space: Minimum 4 GB available space.

**Note:** Microsoft Voices cannot be installed on Windows XP.

Microsoft® .NET Framework. Note: If .NET does not exist on your system, Kurzweil 1000 installs it during the installation process.

DVD drive.

TWAIN-compatible flatbed scanner or document camera. Recognizing and reading currency requires a color scanner.

Sound Card: Creative Labs Sound Blaster®-compatible 16-bit or higher with speakers.

Full-size keyboard and/or a 17-button keypad.

**Before Installing Kurzweil 1000**

Here are some important notes for consideration before installing Kurzweil 1000:

Ensure that you have administrative privileges to install Kurzweil 1000.

The installation is designed for the novice computer user and there will be two options presented to you: one which uses a screen reader and the other which uses the Kurzweil 1000 voice provided. During the installation process, Kurzweil 1000 will ask you to specify which you would like to use. In addition, note that the installation process is self-explanatory, and Kurzweil 1000 provides help throughout the process.

After installing Kurzweil 1000, you must register the product.

Your sessions are limited to two hours until your registration is successful. If after 30 days, you have not registered, you will no longer have the full product.

If you have an earlier version of Kurzweil 1000 on your system, we recommend that you uninstall it before installing Version 14, although it’s not necessary to do so.
There are a couple of situations in which you may not want to uninstall. For instance, you may not want to uninstall Version 7 if you want to keep RealSpeak English, or uninstall Version 8 or earlier if you want to keep the RTK OCR engine.

If Kurzweil 1000 Version 14 is already installed on your system and you attempt to perform an install with the product DVD, a message will indicate that it is already installed and you will then have the option of modifying, uninstalling or repairing the current installation.

Note that Kurzweil 1000 does not install scanners or cameras.

Use the scanner or camera manufacturer’s instructions to install the scanner or camera card, software, and the scanner or camera itself. If you already have Kurzweil 1000 installed and you are installing a new scanner or camera, it’s not necessary to re-install Kurzweil 1000.

Check for the latest information on the installation process from the product Release Notes in the Readme.txt file on the Kurzweil 1000 product DVD.

Depending on your system and the options you select, installation may require up to 15 minutes.

**Uninstalling Kurzweil 1000**

To uninstall an earlier version of the product, use the following procedure. Note, however, that if you want to continue using RealSpeak or RTK, do not uninstall.

1. First open the Start menu from the Windows taskbar.
2. Go to the Programs menu and select Kurzweil Educational Systems.
3. From the Kurzweil Educational submenu, choose Uninstall Kurzweil 1000.

**Installing Kurzweil 1000 Version 14**

There are two options when installing Kurzweil 1000. You can use a screen reader or the Kurzweil 1000 voice provided. By default, Kurzweil 1000 installs in your C: drive. If you want to use a different drive or system folder, you should use the screen reader installation method.

If you want to use the voiced installation, you must exit any screen reader first.

Before you arrive at the place in the installation procedure where you must choose between these two methods, the steps are the same, and we'll cover them now.
1. Make sure you have Administrator privileges.
2. Shut down all applications. Make sure your speakers are plugged in, and set the volume to comfortably hear the screen reader.
3. Place the Kurzweil 1000 DVD in your system's DVD drive. The auto-install process begins. If it doesn't, choose Run from the Windows Start menu. Type: your DVD drive letter, followed by :\setup.exe, then press ENTER to start the setup program.
4. Next, Kurzweil 1000 asks you to choose between voiced installation or screen reader installation. To use the Kurzweil 1000 voiced installation, press the ENTER key. To use the screen reader installation, press the ESCAPE key.

Here the installation process diverges. This guide presents the Voiced Installation first followed by the Screen Reader Installation. If you are planning on using the screen reader, skip over the following section.

**Note:** Because Kurzweil 1000 requires the .NET Framework, the Kurzweil 1000 installer checks for it. If it does not exist on your system, the installer installs .NET before installing Kurzweil 1000. The .NET install could take about 15 minutes.

**To install Kurzweil 1000 using the voiced installation**

This procedure assumes that you have completed the Preliminary Steps and have pressed ENTER to use the voiced installation. Before continuing with the installation, however, note the following keyboard keys and their numeric keypad equivalents, which you can use throughout the voiced installation process:

- **ENTER key** or Accept (top-right key on the keypad) for Yes.
- **ESCAPE key** or Cancel (top-left key on the keypad) for No.
- **F1 key** or the Help and Status key (bottom-right corner on the keypad) for Help; Kurzweil 1000 repeats the prompt.
- **BACKSPACE key** or Rewind (left-most key in row 4 on the keypad) to go back to the previous prompt.

Continue the voiced installation with the following steps:

1. A prompt asks if you want to modify the installation options. Press **ESCAPE** to perform a default installation, or **ENTER** to modify the options. The default installation installs everything except optional features such as Microsoft Speech.
2. If you chose to customize your installation options, the system asks if you want to install the following items. After you hear the name of the item, press ENTER to install or ESCAPE to not install it. The items are Eloquence American English, Eloquence British English, and six Eloquence European languages. Finally, you'll be asked about bilingual dictionaries, and additional FineReader selections.

3. Next, the system asks whether or not you want Kurzweil 1000 to start automatically each time you start your system. Press ENTER if you do not want Kurzweil 1000 to start automatically or press ESCAPE for auto-start.

4. Press ENTER to confirm your choices and proceed with the installation.

5. Sometimes computers need to be shut down and restarted in order to complete an installation. If that is necessary, a prompt will ask whether you want to Restart your computer now or later. (If you choose later, remember that in order to start Kurzweil 1000, you should Restart the system first.) If you elected not to have Kurzweil 1000 start automatically, you can use CONTROL+ALT+K to start Kurzweil 1000. (You may need to Restart your computer first for this keyboard shortcut to take effect.)

6. At this point, you may remove the Kurzweil 1000 DVD.

7. Once Kurzweil 1000 starts up, it reads the license agreement. Press ENTER to accept the agreement.

8. Go to the section entitled, Registering Kurzweil 1000, to register the product.

To install Kurzweil 1000 using the screen reader

This procedure assumes that you've completed the Preliminary Steps and have pressed ESCAPE to use the screen reader for installation. Continue the installation with the following steps:

1. Type your user name.
2. Press the TAB key to go to the organization name. This is an optional entry. If you are using Windows XP, there is an additional option: "Install this application for: Anyone to use..., or Only Me...." TAB to go to this option, and select the Anyone to use option. Press ENTER to continue.
3. Next, press ENTER for Complete install and go to step 8.
4. If you'd rather customize your installation, or you want to place Kurzweil 1000 on a different drive than the default C drive or in a different folder: Press TAB to select Customized.

The Custom Setup dialog opens. The Custom option installs just the files you leave selected in this box. The following are changes you can make:
To remove the feature files you don't want, use the UP/DOWN ARROW keys, stop when you hear the name of the file you don't want and press the SPACEBAR. You cannot remove Main files as they are necessary for Kurzweil 1000 to function.

To change the drive or location in which to place Kurzweil 1000, select Main Files, and then press TAB to go to the Change command. Press ENTER. In the Change dialog, type the name of the desired drive and or location, or press SHIFT +TAB to select another location. Press ENTER to close the dialog. When you are finished, press ENTER to continue with the installation.

5. Next, the system asks whether or not you want Kurzweil 1000 to start automatically each time you start your system. Press ESCAPE for auto-start. Press ENTER if you do not want Kurzweil 1000 to start automatically.
6. The system may prompt you to Restart the computer. If it doesn't, or after you have restarted your computer, you can use CONTROL+ALT+K to start Kurzweil 1000. (You may need to Restart your computer for the keyboard shortcut to take effect.)
7. Once Kurzweil 1000 starts, it reads the license agreement. Press ENTER to accept the agreement.
8. Register the product. Go to the section entitled, Registering Kurzweil 1000.

To install Kurzweil 1000 using the remote silent install option:

The remote silent install installs Kurzweil 1000 to Client computers across a Local Area Network from a central location. If you are a standalone user, please skip this section. This option is provided for Network Administrators who are knowledgeable about MSI packages and have the tools to operate directly on an MSI package.

The following must be installed before performing the MSI install:

Microsoft .Net Framework 4.0 Full

Microsoft .Net Framework 4.0 Full Update KB2468871

Microsoft Visual C++ 2013 Redistributable Package x86 (all operating systems)
Microsoft Visual C++ 2013 Redistributable Package x64 (64 bit OS only, AFTER installing the x86 package)

You will need to specify AUTO=1 (a numeric value) for the Kurzweil 1000 v.14.msi package.
You must also use the Reduced UI option.

An example to launch Version 14 through command line follows:

```
msiexec.exe /i "Kurzweil 1000 v.14.msi" AUTO=1 /qr
```

where /i is the install switch and /qr is the Reduced UI switch.

**Registering Kurzweil 1000**

When you first install Kurzweil 1000, it is in Demonstration mode. In this mode, all features will be available, but each session is limited to two hours. After 30 days, the product expires. To use the full product right away, it's important that you register.

Before you register, here are a few things you must do and know:

1. Consider how you want to register. You can register Online through the software if your system has an Internet connection, or by telephone.

2. Also have the serial number ready. We provide this in both print and Braille in the following places: on your Certificate of Ownership card enclosed with the documentation packaging, (this is a square card with the upper-right-corner cut away), on the outside of the product box, and on the DVD holder.

   If you are upgrading from Version 7 or later, you should use the same serial number with which you registered previously, and the system will remember that number for you.

   If you are upgrading from an earlier version than Version 7, you will receive a new serial number.

   If you purchased multiple Kurzweil 1000 licenses, the serial number for the set is the same.

   During the registration process, you can type or scan the serial number from any of the sources mentioned above.

3. Note the Kurzweil 1000 Customer Service contact information.
4. In the U.S. and Canada use 800-894-5374. For international calls use 781-276-0600.
   Each one of the registration methods is straight-forward, but, if after repeated
   unsuccessful attempts, you still need assistance, please call us.

Preliminary Registration Steps

1. In Kurzweil 1000, open the Help menu. You can use ALT+H.
   Then press G to select Register.
   The first of multiple Registration dialogs opens. Some of the dialogs you'll use
during the registration procedure have theNext and Back commands. Press
ALT+N or the ENTER key to go to the next dialog and ALT+B or ESCAPE to go
back to the previous one. To get from one item to another, press the TAB key. In
the first dialog, your cursor is in the Serial Number box.

2. Type in or scan the serial number.
   If you've registered before, the Serial Number box already contains the number.
   Otherwise, to scan the serial number, place the Certificate of Ownership card,
   product box, or DVD holder, face down in the top-left corner of a flatbed scanner
   or face up in the top-right corner of your document camera's target area. Press
   the TAB key until you hear "Scan." Press ENTER. Kurzweil 1000 scans the serial
   number directly into the Serial Number box in this dialog.

3. Press TAB then press ENTER to open the next dialog box.
   Kurzweil 1000 asks you to select the registration method you want to use. Your
cursor is in a list box and the options include:

      Online or Telephone. The Online option is the default.

      Use the UP or DOWN ARROW to select the desired option.

4. Press ENTER to open the next dialog. Skip to the instructions for the registration
   method you selected.

Registering Online

To use this method, your system must have an Internet connection. If you have a firewall, it must
be configured to accept Internet access requests from Kurzweil 1000. Otherwise, you will receive
messages from the firewall indicating that an unauthorized application is attempting to use the
Internet. You will need a screen reader or an assistant to configure the firewall, or you may call Kurzweil 1000 Technical Support. In the U.S. and Canada use 800-894-5374. For international calls use 781-276-0600.

1. After selecting online registration, one of two things can occur:

   If you have an existing serial number, and it is associated with only one account, Kurzweil 1000 congratulates you and tells you that you have been automatically registered. It then asks if you want to update your account information. If you answer Yes, Kurzweil 1000 automatically fills in your account information in subsequent Registration screens. Make the desired changes and press ENTER to complete registration.

   Otherwise, a dialog opens with the cursor in the Account Type box.

2. If a dialog opens, you can select New or Existing in the Account Type box.

   Select New if you are registering for the first time or with a new serial number. Then go to step 3.

   Select Existing if you’ve registered before. Go to step 3.

   Select Existing - Request Information if you’ve registered before, but have forgotten your password. Press ENTER.

   When Kurzweil 1000 finds your information, it sends the details to your e-mail account. Check your e-mail for the information, then begin the online registration process again. This time, select Existing in the Account Type box.

   If Kurzweil 1000 is unable to find your information, you may have to call Kurzweil Educational Systems Customer Service. In the U.S. and Canada use 800-894-5374. For international calls use 781-276-0600.

3. In the Account name text box, type your account name. Then TAB to type your password in the Password box.

   If you are creating a new account, pick a unique name that’s easy to remember such as your e-mail address. After typing your password, TAB to retype it in the Confirm Password box.
Note: It’s a good idea to note this information for future reference, as when you upgrade to the next version.

4. Press ENTER to connect to the Kurzweil Educational Systems Online Registration page.

The system verifies that you are online, the server is up, the account exists, and that the password is correct. If it finds information that is incorrect or incomplete, it prompts you to make the necessary changes.

Your cursor is in the first of a few online registration dialog boxes. The system prompts for information that is mandatory.

5. Provide or change information. Press ENTER to proceed through these dialog boxes.

6. Press ENTER when you are done.

If registration is successful, Kurzweil 1000 congratulates you. The full Kurzweil 1000 product is now activated.

Registering by Phone

Two notes regarding phone registration:

If you are installing and registering Kurzweil 1000 on multiple machines, then we recommend using the Systems Code Worksheet at the end of the Guide. You can note the systems codes, serial numbers and unlock codes, which can greatly expedite the registration process.

Customer Service representatives are available to take your registration between 8:00 a.m. and 4:00 p.m. Eastern Time. The Customer Service telephone numbers are: 800-894-5374 in the U.S. and Canada; 781-276-0600 for international calls.

The phone registration process follows:

1. Type the unlock code number.

2. Press ENTER.

3. If registration is successful, Kurzweil 1000 congratulates you.
Your Kurzweil 1000 product is now activated.

Exploring Kurzweil 1000

You may want to explore the following helpful resources:

First, in the Readme.txt file in the root folder of the DVD, you'll find information on the latest features and changes in Kurzweil 1000.

The second is the \Extras folder, which contains applications that some of our customers have found to be useful.
2 Tips for New Users

There are a couple of ways to learn how to use Kurzweil 1000:

Go through the New User’s Wizard topics included in the product. The Wizard appears upon Kurzweil 1000 startup, however, you can also access it by pressing the following key combination: ALT+H+W.

Or you can browse the online Help manual, accessible by pressing the following keys: ALT+H+O.

This Tips chapter, however, is designed to give you a jump start.

Keypad or Menu?

There are two different approaches to using the Kurzweil 1000. If you are comfortable with a computer keyboard and already use Windows applications, you might want to use the Kurzweil 1000 menu user interface.

If you want a simpler introduction to the product, start by learning the numeric keypad user interface. There are built-in help systems and documentation for both approaches. You may not want to limit yourself to one or the other. If you are a Windows user and like using the computer keyboard, consider using the keypad interface as a way to quickly access frequently used functions.

Using the Numeric Keypad

The most important key on the keypad is the Help and Status key in the lower-right corner. To find out a key's function, tap the Help and Status key then tap a key you want to identify.

To get a longer, more descriptive explanation of a key’s use, tap Help and Status, then press and hold down the desired key.

Some keys have different functions when they're shifted. You can get help on a key's shifted function by tapping the Help and Status key, then holding down the Shift key and pressing the key for which you’d like information.

Four other frequently used keys are:

Start and Stop Scanning. It's the long vertical key above the Help and Status key.
Start and Stop Reading. It's the long horizontal key in the lower-left corner of the keypad. This key also acts as a Shift key.

Cancel, in the upper-left corner, cancels an action that requires confirmation. Accept, in the upper-right corner, completes an action that requires confirmation.

At any time, you can get Help from the Online Manual by holding down the Shift key (the long horizontal key in the lower left corner of the keypad) and pressing the Help and Status key.

Using the Menu System

The following are general notes about using the Menu System:

Pressing the ALT key on the keyboard gives you access to the main menu bar. You can then use the LEFT and RIGHT ARROW keys on the keyboard (not the keypad) to move among the main menus. As you move to each menu, Kurzweil 1000 speaks the menu name.

Use the DOWN ARROW key to open a menu and move through its items. Kurzweil 1000 speaks a message if an item opens a dialog, if it has a submenu, or if there is a shortcut keystroke. Use the RIGHT ARROW key to access a submenu.

To select a menu item, press the ENTER key on the keyboard. If the item has a dialog, that action opens the dialog.

To get information about a menu item or any part of a dialog, press the F1 key.

To access the online manual, select Open the Manual from the Help menu.

There are also mnemonics, or letter keys that you can press with the ALT key, for speedy selection of menu items. For instance, pressing the ALT key, then the letter H key for the Help menu, and the letter O key for Open the Manual opens the Kurzweil 1000 online manual. As you become familiar with the Kurzweil 1000 menus and their items, using mnemonics will become second nature.

Consider memorizing shortcut keys for menu items you use frequently. Shortcut keys are one to two keys that you press to perform an action. For instance, the F5 Function key Starts and Stops Reading, the F9 key Starts and Stops Scanning, and the F1 key provides help. You can also use standard Windows shortcuts such as the Control key plus letter O to open a file.
Another useful Kurzweil 1000 specific shortcut is Shift plus F9 to recognize currency. While reading, the following shortcuts can be very handy: F12 and F11 increases and decreases reading speed, respectively. Control plus D defines a word. Control plus F lets you find text and Control plus G takes you to a desired page.

For a comprehensive list of shortcuts, use the Quick Reference from the Help menu by pressing ALT plus H, then Q any time while you are using Kurzweil 1000.

Once you have opened the manual, you can, of course, just read it using F5. But since it is a lengthy document, you might prefer to use an index. Press CONTROL+R to access a list of bookmarks. You can move among those bookmarks with the Up and Down Arrow keys. Bookmarks have a structure like an outline. The topmost level will contain chapter titles. You can burrow deeper into the details of a chapter by pressing the Right Arrow, which takes you to subchapter titles. When you have found a subject that interests you, press Enter, and you will be taken to that section in the manual. Finally, CONTROL+F, or Find, allows you to search for a word or phrase in the manual, or in the list of bookmarks.

Starting and Shutting Down Kurzweil 1000

There are three additional helpful shortcuts to know. If you do not have Kurzweil 1000 starting up automatically when you start up your computer, you can start Kurzweil 1000 by pressing CONTROL+ALT+K. Note that you must reboot your computer after you install Kurzweil 1000 for this shortcut to work.

To shut down Kurzweil 1000 using the keypad; press the Cancel key twice, followed by the Accept key. To do so with the menu system, use the Exit menu item under the File menu, or ALT+F, and then X. To power off your computer, which you can do only through the keypad, press the Cancel key three times followed by the Accept key.

Finding Help and Information

Wherever you are in the product, Kurzweil 1000 provides audio feedback through the Verbosity feature and the messaging system. However, the following is a short list of the many ways in which you can find additional Help and information:

The F1 key gives you information about the current control.

The F2 key provides Help for the current dialog box.
For the Online Help Manual, press ALT+H, then O. In the manual, you can use Bookmarks and the Find feature to go to and/or search for the information you want. Press CONTROL+R to access Bookmarks. You can move among bookmarks with the Up and Down Arrow keys. Bookmarks have a structure like an outline. The topmost level will contain chapter titles. You can burrow deeper into the details of a chapter by pressing the Right Arrow, which takes you to subchapter titles. To go to a desired subject, press ENTER. You can use CONTROL+F, or Find, to search for a word or phrase in the manual, or in the list of bookmarks. Note that on the keypad, pressing the Shift (the long horizontal key in the lower left corner of the keypad) and the Help and Status keys opens the manual.

There's also a Quick Reference, which provides a comprehensive list of shortcut keys. Press ALT+H, then Q to open the Quick Reference.

If you want information about the version of Kurzweil 1000 that you are using, press ALT+H, then A.

If you would like to refresh your memory about the use of the function keys, press the help key in the numeric keypad, followed by the function key itself.

A good way to find help is through other users. You can do this by signing up for Kurzweil 1000 email listserv. Go to the following Web Page:

https://www.kurzweiledu.com/support_listserv_signup.asp

Or send an email to imailsrv@kurzweiledu.com

The body of the message should contain one line. If you are sending the message from the e-mail account that you wish to use for the list, the message should simply read as follows: subscribe K1000.

If you intend to use a different e-mail address for the list, then the message should read as follows: subscribe K1000 followed by the e-mail address.
3 Version 14 New Features.

There may have been additional features added after this document was printed. For those, refer to the Readme file on the product DVD.

The following is a summary of what's new in Version 14. Note that some of these features were made available previously in patches for Version 13. They are included here so that the new features guides can include them. For complete details, go to the online Manual by pressing Alt+H+O. Where applicable, search key words are provided for you to use in the online Manual.

File Operations.

Extracting Images into PDF Files (File->Utilities->Extract Images->PDF… or TIFF… and File->Utilities->Extract All Images->PDF… or TIFF…).

Extract Images and Extract All Images both contain submenu choices “PDF…” and “TIFF…” The shortcut keys are P for PDF and T for TIFF. They bring up a dialog for extracting and saving the images. If you choose TIFF a dialog asks for a folder into which the image files will be written. If you choose PDF a dialog asks for a filename to contain all of the images found in the file. Note that the PDF will only contain images. It will not have any recognized text. To recognize text, use KOCRUtil to process the PDF, specifying PDF also as the output format. The resulting file will still have the images, but it will also contain the recognized text, allowing others access to the contents with Acrobat Reader.

PNG has been Added as a Supported Image Format.

You can now use File->Open to select and recognize a PNG file.

Suggest a File Name, even for a Document Created by Typing.

Like scanned documents and even multipage copied documents, documents created by typing a single page now suggest a file name when one attempts to save a file. It suggests a name built from the contents of the file.
Scanning and Recognition.

OCR Upgrades.

We try to keep up with the most recent updates in optical recognition technology. This version supports ABBYY FineReader Version 11, and OmniPage Version 19. These are available from Kurzweil 1000 itself, and also from KOCRUtil. Recognition of images made with document cameras has been improved. KOCRUtil can now be used to take a standard PDF file, which may not be accessible, and create a tagged PDF file, which can be read with the voice tools in the standard version of Acrobat Reader. Note that previous versions of Kurzweil1000 used a different name for OmniPage – ScanSoft. This was done at the request of the vendor. They have changed their mind, so we now are using the name that this technology normally goes by – OmniPage.

A New Scanning Mode (Settings->Scanning->Mode->Create a PDF File).

Create a PDF File is a new scanning mode. Selecting this mode creates an image-oriented PDF file. It is the first choice in the Mode setting in the Scanner settings dialog. The first scan after this mode is selected brings up a file dialog requesting the name of a PDF file. You can specify a new filename or an existing filename. Thereafter, until the scanning mode is changed or you exit from Kurzweil 1000, a scan will result in one new page for the PDF file.

It is possible to scan one side of a multipage double-sided document by first doing the odd numbered pages ascending, followed by using the Scan->Flip menu item and then scanning the even numbered pages, beginning with the back side of the last odd-numbered page scanned and then descending down to the back side of the first page scanned. If more scans follow, they are appended to the end of the document, making it possible to do double-sided scanning in groups: Odd ascending, then Even descending, then Odd ascending and Even descending again.

It is possible to create multiple PDF files with this scanning mode, but it requires the process of going back to the scanning settings dialog, changing the scanning mode to another setting, applying the change, and then changing back to the Create a PDF File mode.

Note that the PDF files created with this technique are image only and largely inaccessible to the blind. You can, however, use KOCRUtil or Kurzweil 1000 itself to recognize the PDF file. If you use KOCRUtil, you can also specify to create a new PDF as output. That file will be accessible and readable by voice with Adobe Reader.
Use Bookmarks to Select a Page Range for Recognition

If you open a PDF file that contains multiple pages, you can select a starting and ending page number. This is existing functionality. Now, if you change the range from “All” to “Pages” and tab, you will be told this as well: “You may press CONTROL+B to select a page number based on bookmarks in the document." This is useful for specifying a section of a PDF file.

If you press CONTROL+B, you will get a list of bookmarks which have been extracted from the PDF file. They are ordered by page number, and the page number is prepended before each bookmark description. For the From page number, the default position is at the first bookmark. For the To page number, the default position is at least the page number specified in the From page number. If you select a bookmark and press F7, it reports the level, the page number, and the description. If you select one of these bookmarks and press enter, the list will close, and the page number associated with the bookmark will be entered in the text box. This can be done to set both the From and the To page numbers.

Recognition Engine Hint Message can now be Repeated.

The second press of Shift+F1 will repeat the most recent recognition engine hint, if any has been spoken in the current session.

Reading.

Voiceware Speech Update.

The voices we supply with NeoSpeech – VW Kate and VW Paul – have been updated. We also have added one new voice, VW James.

Read Current Note (Read->Read Current Note)

A new menu item has been added to the Read menu, “Read Current Note.” It is located immediately below “Read a Note.” To read the current note choose Read Current Note from the Read menu (or press ALT+R+U) or ALT+Shift+Q. It will read the contents of the current text note, or it will play the current voice note. If there is no note positioned at or very near the current word, the message "There is no note at the current word." will be spoken.
When it plays a voice note, it brings up a dialog. If you let the note play through to the end, the dialog will automatically close. If, however, you tab, the voice recorder dialog will activate and you can make use of the other features.

**A Quick Mechanism for Proofreading.**

Pressing ALT+F5 will cause Kurzweil 1000 to start reading continuously, and will announce all punctuation marks. When reading is stopped, the punctuation level will automatically return to whatever it had been set at.

**Editing.**

**More Ways to Copy, Cut, and Paste Text.**

You can now copy and cut plain text as well as formatted text. You can also paste text from the clipboard in a manner that ignores the formatting. Just add the shift key into the appropriate key combination. To copy plain text, use Control+Shift+C, to cut plain text, use Control+Shift+X, and to paste plain text use Control+Shift+V. You can also copy and cut in a manner that will append text to the clipboard rather than replacing what is already on the clipboard. Add the Alt key into the key combination. To append to the clipboard, use Control+Alt+C or Control+Alt+X. You can also append plain text. Use Control+Shift+Alt+C or Control+Shift+Alt+X. The various copy and cut key combinations will also interact with multipage selection using a mark, or using select all.

**Voice Notes (Edit->Record a Voice Note).**

A new menu item, Record a Voice Note, has been added after Create a Note. Its mnemonic is ALT+D which will bring up a dialog which is used for recording a voice note and for playing it back.

**Record, Load, OK and Cancel** are the only buttons enabled when the dialog first opens. After you start recording, the **Save** button is enabled.

**Record / Stop:** Toggle – starts and stops recording – press **Record** to activate the microphone to begin or continue recording a voice note, press again to **Stop** recording. Whenever you press the **Stop** button, the **Play** button is enabled.

**Load (ALT+L):** To select an existing MP3 file, whose contents will be copied to the voice note. After you load a file, the buttons for playback are enabled.
Save (ALT+S or S): Brings up a dialog to specify an MP3 file in which to copy the audio contents of a note. After you Save a file, all the buttons for playback are enabled.

OK (Enter): To accept the recording and close the dialog.

Cancel (Escape): To cancel the creation of the voice note and close the dialog.

To play back a recording:

Play / Pause (Alt+P or F5): Toggle – starts and pauses playback – press once to Play, press again to Pause.

Back (ALT+B or F6): In playback, to move back by one second (if the recording is short) otherwise by five seconds.

Forward (ALT+F or F8): In playback, to move forward by one second (if the recording is short) otherwise by five seconds.

Home (ALT+H or the Home key): In playback to move to the beginning of the recording.

End: In playback, to move to the end of the recording.

When you have made and accepted a recording, a voice note is entered into the current cursor position at the current page. There is no visual representation of the voice note, but if you read past it (and if the chime for reading past a note is enabled) a chime will indicate its presence.

To get to a note, choose Read a Note from the Read menu (or Press ALT+R+Control+Q).

The description for any voice note in the list of notes will simply be "Voice Note" - there can be any number of such notes. If you press Enter, the dialog described earlier will come up with all of its buttons enabled, and the sound note will start playing. If it is played to its end without interruption, it will automatically close, and control will return to the edit window. Pressing any other button while playback is in progress will activate that button's behavior, and will also require pressing OK or Cancel to close the note. You can choose to re-record the note if you wish.
Editing and Announcement of Subscripts and Superscripts.

A new setting, Position, has been added in the font format properties dialog (Edit->Format->Font). The Position choices are Normal, Superscript (Control+Shift+Plus Sign), and Subscript (Control+Plus Sign). These keyboard shortcuts toggle between subscript or superscript and normal. When reading, the word Subscript is inserted before one or more subscripted characters and the word Superscript is “announced” between one or more superscript characters.

Quickly Change the Case of some Text

The ability to modify the case of selected text has been added. This is available with a new menu item: Edit->Format->Case. The mnemonic for Case is "C". There is no short cut. Beneath it there are the following options: Lower, Upper, and Title. Their mnemonics are "L", "U", and "T". An error message will be spoken if no text is selected. Otherwise, the selected text is modified: for lower, all alphabetic text is turned to lower case, for upper, to upper case, and for title, lower case except that the first alphabetic character of each word becomes upper case.

Note that this can work in conjunction with the multiple page selection mark and also select all, though neither is recommended, as this has no intelligence regarding proper names, the word "I" in English, or the first letter of each sentence. It is best used for relatively short blocks of text.

Navigation.

Go to Phrase (Navigation->Go to Phrase).

A new menu item has been added to the Navigation menu immediately below Go to Bookmark. There is no hot key, but the mnemonic is H.

The idea of this feature is simple. Suppose you are reading a long novel by, say Dostoevsky, with a few hundred characters, all with Russian names. To keep track of these characters, use “Go to Phrase” to remind yourself of who these characters are. You can read the sentences containing the name in the list, or press enter and go to that spot in the document for further information.

Go to Phrase brings up a dialog that contains one combo box, an OK button, and a Cancel button. Use it to specify a word or phrase that you want to find in the document. It searches for all occurrences of the phrase and if it finds some, it brings up a dialog very similar to the
bookmark dialog. It will list a number of sentences containing the phrase. The list is arranged in reading order. Just like the bookmark dialog you can modify descriptions.

Phrases can contain multiple words. If they do, partial words can be included in the match. If they contain only one word, partial words will not be matched. Matches are not case sensitive.

Over time the list may contain phrases that you have successfully searched for in the current document. When you bring up the Go to Phrase dialog it will initialize itself to a phrase found on the current page, if one is found.

The phrases themselves, as well as their positions, can be saved in the KES file, making it easy to build a collection of these phrases for any document.

Navigate in a Thesaurus or Dictionary Definition

You can now use ALT+Home in the definition or thesaurus dialog to go to the start of the current definition, and ALT+End to go to the end of it.

Search for a Page with a Full-Page Image

The third control in the Find dialog allows you to do some special searches. One new one has been added to the end of the list: “A page with an image.” Once you have found a page in this manner, you can use F3 to search for the next such page, and SHIFT+F3 to search for a previous page with a full-page image.

Create a Paragraph Based Bookmark

Although CONTROL+B is the normal shortcut for creating a bookmark, if you’d rather use CONTROL+B to enable and disable bold formatting, use CONTROL+SHIFT+G to bookmark the current paragraph. This will only work if nothing is selected.
**Create a Bookmark using a Mark**

Mark a Position adds another way to create a bookmark. If a mark is before the current position, the mark becomes the position where the bookmark is made. Note that the text between the mark and the current position can be on a different page.

**Mark or Unmark a Position (Edit->Mark or unmark a Position)**

This feature is now a toggle. The shortcut key is CONTROL+M. Press once to set the Mark. If there is already a mark set in that position, CONTROL+M removes that mark.

**Tools, Verbosity, and Help.**

**American Heritage Dictionary – Fifth Edition.**

We have updated the American Heritage Dictionary to Version 5.

**Spell Checking Bookmark and Note Descriptions.**

A new setting, Check Spelling, has been added to the General Settings dialog. It is immediately after the setting for reading newly recognized pages. Its mnemonic is S. It is a list box with three options: Document Only, Notes and Bookmarks Only, and Everything. The everything setting spell checks both the Document and the Notes and Bookmarks.

**The Spell Checker has Changed.**

Kurzweil 1000 is now using an open source spell checker named Hunspell (.Net version NHunspell). This spell checker does a better job and brings up a longer list of suggestions for misspellings. So far nine spelling dictionaries are supplied: American English, British English, Dutch, French, German, Italian, Portuguese, Spanish, and Swedish. For more information about additional dictionaries go to [www.crawler-lib.net/nhunspell](http://www.crawler-lib.net/nhunspell). If you add dictionaries place the two files for each (one with an AFF extension and one with a DIC extension) in the folder named “Common Files” (Program Files (x86)->Kurzweil Educational Systems->Common Files or Program Files->Kurzweil Educational Systems->Common Files).

Spelling dictionaries are automatically loaded based on the language of the reading voice you use. If you don’t use active speech in Kurzweil 1000, the language specified as a
recognition language by your OCR engine will be used. If you install one of your own, you can select it in the Spelling Properties dialog, using a list labeled “Dictionary Name”. This is a new setting in the Spelling Properties dialog.

**Spelling Can be Interrupted.**

When Kurzweil 1000 spells a word, the word is spoken first, and then the word is spelled. Now, by selecting the hotkey twice, the spoken word can be interrupted and you will only hear the spelling.

**Bookshare “Freely Accessible” Books**

Bookshare.org has some freely available books which are available without a login. The words "(Freely Available)" will follow those titles in the list of books returned when you do a search. If you select one or more of those books, they will be downloaded without first asking for a login.

**Removed Features**

News from KESI. The Online->News from KESI menu item has been removed. Marketing has no plans for new articles.

**Additional Changes and Enhancements.**

For the most up-to-date list of changes, please refer to the Read Me file on the product DVD.

**Have Ideas for New Features or Enhancements?**

Wondering what we might include in the next version? Have an idea for a new feature or an enhancement? Use the Kurzweil 1000 listserv. To sign up for the Kurzweil 1000 e-mail listserv go to

https://www.kurzweiledu.com/support_listserv_signup.asp

or send an email to imailsrv@kurzweiledu.com.

The body of the message should contain one line. If you are sending the message from the e-mail account you wish to use for the list, the message should simply read as follows: subscribe K1000.
If you intend to use a different e-mail address for the list, then the message should read as follows: subscribe K1000 followed by the e-mail address.
4 Systems Code Worksheet

If you are installing and registering Kurzweil 1000 from multiple machines, and are using the phone registration option, completing the worksheet provided on the next page before calling Customer Service can help to expedite the process.

As you go through the installation process note these numbers for each machine. They are necessary for obtaining a corresponding unlock code, which you will then need to activate each installation of the software.

Space is also provided on the worksheet for the location of each machine, and for the corresponding unlock code which the Customer Service representative will provide to you.

For complete details and instructions on product registration, and specifically, Registering by Phone, go to *Installation and Registration* at the front of this Guide.
## Systems Code Worksheet

<table>
<thead>
<tr>
<th>Machine Location</th>
<th>Serial Number</th>
<th>Systems Code</th>
<th>Unlock Code</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Systems Code Worksheet

<table>
<thead>
<tr>
<th>Machine Location</th>
<th>Serial Number</th>
<th>Systems Code</th>
<th>Unlock Code</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>